Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.

Our mission is to:
1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it’s our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there’s no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
Ulritouch+ Ultrix · User Guide

- Ross Part Number: 2201DR-904-02
- Release Date: September 7, 2022.

The information contained in this Guide is subject to change without notice or obligation.

Copyright

©2022 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents


Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Safety Notices

Refer to the “Important Regulatory and Safety Notices” document that accompanied your product.

Statement of Compliance

This product has been determined to be compliant with the applicable standards, regulations, and directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is available upon request by contacting techsupport@rossvideo.com. Please include the product; model number identifiers and serial number and country that compliance information is needed in request.

EMC Notices

United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user’s authority to operate this equipment.
European Union
This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.

Australia/New Zealand
This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea
This equipment is in compliance with the provisions established under the Radio Waves Act.
Class A equipment (Broadcasting and communications service for business use).
This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is intended for use in areas outside home.

<table>
<thead>
<tr>
<th>Type of Equipment</th>
<th>User’s Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 방송통신기자재)</td>
<td>이 기기는 업무용 A급 전자파적합기기로서 반매자 또는 사용자는 이 점을 주의하시기 바랍니다. 가정외의 지역에서 사용하는 것을 목적으로 합니다.</td>
</tr>
<tr>
<td>Class A Equipment (Industrial Broadcasting &amp; Communication Equipment)</td>
<td>This equipment is <em>Industrial (Class A) electromagnetic wave suitability equipment</em> and seller or user should take notice of it, and this equipment is to be used in the places except for home.</td>
</tr>
</tbody>
</table>

International
This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

Warranty and Repair Policy
The product is backed by a comprehensive one-year warranty on all components.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.
Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information, contact your regional sales manager.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.
To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.
The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products.
This appliance may contain a Coin type battery which should not be treated as household waste.
To ensure that the battery will be treated properly use the appropriate take-back systems in your area. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
Drawers ................................................................................................................................................... 35
Accessing the Operations Features ..................................................................................................... 35
Filtering the Destination and Source Buttons .................................................................................... 36
Loading a Soft Panel on Ultritouch .................................................................................................... 36
Switching with a Level, Destination, and Source ................................................................................ 37
Using Presets ............................................................................................................................................ 38
Editing the Preset List ........................................................................................................................... 38
Using Salvos .............................................................................................................................................. 38
Recalling a Salvo .................................................................................................................................... 39
Using Favorites ......................................................................................................................................... 39
Using the Output Monitor Window ........................................................................................................ 39
Configuration Requirements ................................................................................................................ 40

Multiviewer Operation 43
Before You Begin ...................................................................................................................................... 43
Soft Panel Overview ................................................................................................................................. 43
Creating a Soft Panel for Multiviewer Operation ................................................................................ 44
Home View of an Ultritouch MV Soft Panel ........................................................................................ 46
Using an Ultritouch MV Soft Panel ......................................................................................................... 46
Layout Control ....................................................................................................................................... 46
PIP Selection .......................................................................................................................................... 47

Using Categories 49
Using Category/Index Mode ................................................................................................................... 49
Before You Begin ................................................................................................................................... 49
Soft Panel Overview ................................................................................................................................. 49
Creating a Soft Panel for Category/Index Mode ................................................................................... 50
Using Category/Index Mode ................................................................................................................... 52
Using Group Categories .......................................................................................................................... 53
Before You Begin ................................................................................................................................... 53
Soft Panel Overview ................................................................................................................................. 53
Using Group Categories on a Soft Panel ............................................................................................... 54

Glossary 57
Introduction

This guide covers the installation, configuration, and use of the Ultritouch with your Ultrix router. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Soft Panels for Ultritouch” summarizes the available DashBoard interfaces for configuring and managing soft panels to be used on the Ultritouch.
• “Getting Started” provides an overview for creating a routing system with Ultritouch, and general information to keep in mind before installing and configuring your Ultritouch panel.
• “Communication Setup” briefly summarizes how to install a license key, and establish communications between the Ultritouch and the Ultrix router.
• “Creating a Soft Panel for Ultritouch” provides instructions for using the options in the Panel Editor for an Ultrix router to create a soft panel that can be loaded to an Ultritouch.
• “Using Soft Panels” provides instructions for loading a soft panel to Ultritouch, and how to perform crosspoint switches using the loaded soft panel.
• “Using Categories” provides an overview of how to use Cat/Index mode on an Ultrix router via a soft panel on the Ultritouch.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your Ultritouch:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Ultritouch Quick Start Guide, Ross Part Number: 2201DR-102
• Ultritouch User Guide, Ross Part Number: 2201DR-104
• Ultrix User Guide, Ross Part Number: 2101DR-004
• Walkabout Application Note, Ross Part Number: 2201DR-003

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Edit dialog, click Insert Above.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.
Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the *Ultritouch User Guide*.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow.
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

* Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
- **E-mail**: techsupport@rossvideo.com
- **Website**: [http://www.rossvideo.com](http://www.rossvideo.com)
Soft Panels for Ultritouch

A soft panel provides Ultritouch access to the sources, destinations, levels, and/or salvos that are available on the associated Ultrix router. The soft panel configurations are part of the Ultrix database so any instance of DashBoard or Ultritouch connecting to a given router has the defined soft panels available.

This chapter summarizes the elements of a soft panel for Ultritouch, and the interfaces used to create and manage these soft panels in your Ultrix database.

For More Information on...
• Ultritouch configuration, refer to the Ultritouch User Guide.

Overview of the Ultrix Soft Panels Editor

Ultrix provides a template for creating soft panels that can be loaded and used on an Ultritouch to control the Ultrix routing system. The required template is available in the Ultrix> Database > Panels interface in DashBoard for the router. Once you configure and save the soft panel to the router database, you can then load the soft panel onto any Ultritouch communicating with that router.

The soft panel editor is organized into six selectable tabs. Each tab, starting from left to right, is briefly summarized below.

For More Information on...
• the Panels interface for an Ultrix router, refer to the Ultrix User Guide.

Info Tab

Use the options in the info tab to assign a unique identifier to the soft panel, and how the panel will perform tasks as Take transitions. This is the default tab that the interface opens on.
Levels Tab
Use the options in the Levels tab to specify the number of levels for the panel, and organize them in a hierarchy for the panel.

Destinations Tab
Use the options in the Destinations tab to specify which router outputs will be available in the Destination window of the soft panel.

Sources Tab
Use the options in the Sources tab to specify which router inputs will be available in the Source window of the soft panel, and establish their hierarchy.

Salvos Tab
Use the options in the Salvos tab to specify the total number of salvos displayed in the soft panel and their hierarchy.

Home View Tab
The options in the Home View tab enable you to customize the layout and display settings of the soft panel when it is loaded to an Ultritouch. From here you determine the order of the drawers and windows, whether the buttons display icons and labels or just labels, and customize the properties of each drawer and window.

Elements of an Ultritouch Soft Panel
To control an Ultrix router via Ultritouch, load a saved soft panel using the Ultritouch > All Connections interface. Loading a soft panel to Ultritouch requires a similar method as loading a soft panel in the Ultrix and/or Ultricore menu system. You select the device in the Ultritouch > All Connections interface, navigate to the specific soft panel you wish to load, and select it from the provided list. Soft panels are listed in a hierarchy as determined by their Panel ID.

The layout of the soft panel depends on how it was configured in the Ultrix Panel Editor. The order of the windows in the soft panel is determined using the options in the Home View tab. Refer to “Defining the Home Page of the Soft Panel” for details.

Figure 2  Example of an Ultrix Soft Panel Loaded to an Ultritouch

1. Main Toolbar
This toolbar is fixed to the left side of the soft panel as part of the Ultritouch window and provides navigation buttons to access custom panels, connected devices, and file management. Refer to the Ultritouch User Guide for details.
2. Home Page

This area is the Home Page of the soft panel and displays the windows defined during the soft panel configuration. By default, the Ultritouch PB soft panel template includes two drawers (3), a Destination window (4), a Sources window (5), and an Operations window (7). Figure 2 shows a customized soft panel that also includes a Status window (6) and an Output Monitor window (8). Each of these elements are summarized below.

3. Drawers

A navigation drawer is available on the left and right sides of the interface. Tap the drawer icon once to open a pane that provides access to additional menus and functions of your soft panel. Tap the drawer icon again to close the pane. The contents of a drawer is determined when the soft panel was configured.

4. Destination Window

Each button in this area represents a configured output for the selected router. Tap a button to include the destination in the next crosspoint switch. For example, Dest1 is selected in Figure 2. Note that the number of destinations and the button labels are defined in the Ultrix > Database > Destinations interface. The icon used on the button type (e.g. the headphone icon is used in Figure 2) is specified during the soft panel configuration.

5. Sources Window

Each button in this area represents an input in the routing system. Tap a button to include the source in the next crosspoint switch. For example, Src12 is selected in Figure 2. Note that the number of sources and the button labels are defined in the Ultrix > Database > Sources interface. The icon used on the button type (e.g. the camera icon is used in Figure 2) is specified during the soft panel design.

6. Status Window

Tap a level button to include that level in the next crosspoint switch. Note that the number of levels and the button labels are defined in the Ultrix > Database > Levels interface. This window also displays the status of crosspoint selections. In Figure 2, Dest2 is selected for the next crosspoint switch.

7. Operations Window

This window of the soft panel groups operational features as defined when creating the soft panel. The following buttons can be located in this window:

- **LOCK** — This button displays when the Protection Operation was set to Enable during the soft panel design. Tap this button to prevent switching of the selected destination by any control device.
- **PROTECT** — Tap this button to prevent switching of the selected destination except by the panel that initiated the protect. If you are using a soft panel with the Protection Operation set to Disable, the PROTECT button is not displayed.
- **FOLLOW** — Tap this button to automatically select all the Level buttons listed on the soft panel (buttons are now lit). All levels are included in the next crosspoint selection.
- **VIEW** — Tap this button to display a list of presets that will be included in the next crosspoint switch.
- **CLEAR** — Tap this button to clear the selections made for the next crosspoint switch on the soft panel.
- **PRESET** — Tap this button to create a temporary list of multiple crosspoint switches that will be executed on the next transition.
- **TAKE** — Tap this button to execute the switch between the selected crosspoints. The soft panel does not display this button if the Take Operation was set to Direct during the soft panel design. Transitions will occur automatically after a crosspoint switch is selected.
This window also includes a read-only status field, located at the top of the window, that reports the currently selected destination.

8. Output Monitor Window

This area provides a thumbnail preview window of the next crosspoint switch. Refer to “Using the Output Monitor Window” for more information.
Getting Started

This chapter summarizes the steps required for configuring the Ultritouch and Ultrix connection.

Before You Begin

Keep the following in mind when managing your Ultrix soft panels for Ultritouch:

- Soft panels require the setup of the database source/destinations/levels and port assignment to be complete on the Ultrix router that will communicate with Ultritouch.
- If the Ultrix database changes (source/destination/level/salvo addition or deletion), you will need to:
  - update the Ultritouch soft panel configuration in the Ultrix database to ensure the correct elements are visible;
  - re-load the soft panel to the Ultritouch.
- Soft panels do not support Unicode characters.

Configuration Workflow

Refer to Figure 3 for an overview of the steps required before establishing communication between the Ultritouch and an Ultrix router.

![Figure 3 Example Workflow for Setting Up an Ultrix Before Connecting to an Ultritouch](image)

Refer to Figure 4 for an overview of the steps required to enable your Ultritouch to communicate with an Ultrix router.

![Figure 4 Example Workflow for Setting Up an Ultritouch to Communicate with an Ultrix](image)

Configure the Ultrix Database

A database defines the matrices, levels, sources, destinations, and soft panel for a particular router setup. A router may use a number of database configurations depending on its role in the routing system.

For More Information on...

- creating and managing databases for an Ultrix router, refer to the Ultrix User Guide.

Create the Ultritouch Soft Panel in the Ultrix Database

A soft panel is a software implementation of a physical remote control panel (RCP). You can customize an Ultritouch soft panel by defining the sources, destination, levels, and/or salvos that
will be available for use on the panel interface. A soft panel designed for Ultritouch also enables you to customize the look of the interface when it is loaded to the Ultritouch panel.

★ An Ultritouch soft panel is created using the options in the Ultrix menu system.

Install the ULTRITOUCH-RTR License Key
Ross Video uses license keys to control user access to specific Ultritouch features. In the case of an Ultrix router, you must install the ULTRITOUCH-RTR license key on the Ultritouch before it can communicate with a router.

Set up Communications between the Ultritouch and the Ultrix
Communication between Ultritouch and the Ultrix router is over ethernet via an established connection point. A connection point defines the interface and the protocol to be used for communication.

Load the Ultritouch Soft Panel to Ultritouch
The main toolbar on the Ultritouch provides a method for navigating to the soft panels available in your routing system. Loading a soft panel to an Ultritouch is similar to loading a soft panel to an Ultrix router or Ultricore Central Controller: from the main toolbar you locate the soft panel in the Panel tree of the database (panels are listed in a hierarchy as determined by Panel ID), and open it.

★ Do not load a soft panel that is not designed specifically for an Ultritouch. A soft panel, other than one designed using the Ultritouch PB template, may not display correctly on the Ultritouch screen.

Use the Ultritouch Soft Panel
The layout of an Ultritouch soft panel automatically organizes the destinations, sources, and levels into distinct columns of buttons. Refer to “Elements of an Ultritouch Soft Panel” for more information.
Communication Setup

Ross Video uses license keys to control user access to specific Ultritouch features. This chapter outlines how to install the ULTRITOUCH-RTR license for your panel, and set up communications between an Ultritouch and an Ultrix router.

* You must have the Ultrix router and the Ultritouch configured in your routing network before proceeding. Refer to the Ultritouch User Guide for details.

Installing a License Key

Before setting up communications between your Ultritouch and an Ultrix and/or Ultricore, you must first install the ULTRITOUCH-RTR license on your Ultritouch.

To install an ULTRITOUCH-RTR license for your Ultritouch

1. Tap  
2. Tap License Management.

* This may also be accessed via a DashBoard client computer and navigating to the Ultritouch Device > Manage Licenses interface.
3. Locate the row for the ULTRITOUCH-RTR license.
5. Contact your Ross representative.
   a. When you speak to your Ross representative, tell them your name, facility name, and the Request Code from 4.
   b. You will be given a License Key that must be entered in the License Key field for ULTRITOUCH-RTR.
6. Enter the provided License Key in the License Key field for ULTRITOUCH-RTR.
7. Tap Install Key.

Communications between Ultritouch and Ultrix/Ultricore

Ultritouch uses the open SLP protocol to locate devices on the same network as it is connected to. There are two methods to setting up communications between the Ultritouch and Ultrix/Ultricore: using the auto-connect feature or manually adding the router by specifying its IP address.

To set up a connection point between Ultritouch and Ultrix/Ultricore

1. Tap  
2. Tap Connected Devices.

* This may also be accessed via a DashBoard client computer and navigating to the Ultritouch Device > Device Options interface.
3. Tap Add.
4. Tap Manually Add a Connection Point.
5. Use the Device IP/Hostname field to specify the IP Address for the Ultrix router.
6. Tap Add Device.
   The router is now listed in the Connected Devices table.
7. Select the router from the **Connected Devices** table.
8. Tap **Connect**.
Creating a Soft Panel for Ultritouch

The Ultrix Soft Panels Editor enables you to specify the number of destinations, sources, levels, and salvos displayed on your panel. You specify the elements of the soft panel, such as what windows and additional menus to display and their order on the soft panel, and give the panel a unique name to make it easier to identify in your system. This chapter outlines how to create a soft panel (Ultritouch PB) specifically designed for use on an Ultritouch using the Ultrix Soft Panels Editor in DashBoard.

Before You Begin

Creating a new soft panel, or editing an existing soft panel, requires you to work within the Ultrix database menu system. Before proceeding:
- create and load the required database to the Ultrix router;
- be familiar with using the Soft Panel Editor in the Ultrix menu system.
- ensure the soft panel you are editing is not currently loaded on an Ultritouch.

For More Information on...
- managing a router database, refer to the Ultrix User Guide.

Creating a New Soft Panel for Ultritouch

Much like other types of soft panels, when you create a new Ultritouch PB soft panel, you select from an existing soft panel type (templates). You then assign a Panel Name and ID to display in the tree view using the nomenclature "Panel Name [\#]" where [\#] is the Panel ID.

To create a new soft panel for Ultritouch
1. Locate the Ultrix in the Tree View of DashBoard.
2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.
3. Expand the Database node.
4. Double-click the Panels node.
   - The Panels tab opens.
5. Click **Edit... > Add.**

The **Add Panel** dialog opens.

6. Type a unique identifier in the **Name** field. This will be used to identify the panel in the tree under the Soft Panels node.

7. Use the **Style** menu to specify **Ultritouch PB**.

8. Click **Apply** to save your settings and close the **Add Panel** dialog.

The new panel name is added to the **Saved Panels** list of the **Panels** tab and is automatically selected for editing. In the following example, the **ultritouch_2** soft panel was created.

---

**Adding Operation Features to the Soft Panel**

You can customize the Operations window to include, or not, specific operational buttons used when switching crosspoints.
To edit the soft panel operational features

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.
2. Click Info.
3. Use the Description field to provide a textual summary of the panel.
4. Use the Protection Operation menu to provide options for preventing crosspoint switches. Choose from the following:
   - Enable — The LOCK, PROTECT, and FREE buttons display on the soft panel. This is the default setting for Ultritouch soft panels.
   - Disable — The LOCK, PROTECT, and FREE buttons do not display on the soft panel. These protection options are not available for the soft panel.
5. Use the Take Operation menu to configure the TAKE button for the soft panel. Choose from the following:
   - Confirm — Displays a TAKE button on the soft panel. You must select the TAKE button to perform a crosspoint switch.
   - Direct — The soft panel does not display a Take button. A crosspoint switch occurs automatically after each destination/source selection is made by the user on the soft panel. This is the default setting for Ultritouch soft panels.
6. Use the Machine Control menu to control whether a Take request directed to an Ross NK-M series data router automatically makes a reciprocal port switch. Choose from the following:
   - Enable — Displays a Machine Control button on the soft panel. You must select the Machine Control button to enable the reciprocal port switch on the NK-M series router.
   - Disable — The soft panel does not display a Machine Control button. This is the default setting for Ultritouch soft panels.
7. Click Apply to save your new soft panel.
8. Continue to the next sections to add levels, destinations, sources, and salvos to your soft panel as required.

Levels for the Soft Panel

You can specify the total number of levels available on the soft panel to the user. For example, if you set the Viewable levels to 6 but have assigned 8 levels to the panel, only the first six levels in the Assigned list are displayed. You can also specify the order in which the levels are displayed on the soft panel.

To specify the levels for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.
2. Click Levels.
3. Use the **Viewable levels** field to specify the total number of levels for the soft panel.

4. To add a level to the soft panel:
   a. From the **Available** list, select the level(s) you wish to add to the soft panel.
   b. Click ➡️.

   The **Assigned** list updates to include the selected level(s).

5. To assign all the available levels in the database to the soft panel, click ➡️.

6. To assign multiple levels to the soft panel:
   a. From the **Available** list, select the first level you wish to add to the soft panel.
   b. Press **Shift**.
   c. From the **Available** list, select the other level(s) you wish to add to the soft panel.
   d. Click ➡️.

   The **Assigned** list updates to include the selected levels.

7. Use the provided buttons beside the **Assigned** list to determine the order in which the levels are displayed on the soft panel.

8. Click **Apply** at the bottom of the Panels tab to save your settings.

**Destinations for the Soft Panel**

You can create a soft panel with a specified number of destinations and determine the order in which they are displayed in the Destinations window of the panel. For example, the router may have 32 destinations but you only want to make the first 4 outputs selectable on the soft panel. You would then move only the required destinations from the Available list to the Assigned list.

**To specify the destinations for the soft panel**

1. Double-click the soft panel name from the **Panels** list in the left toolbar of the **Panels** tab.
2. Click **Destinations**.
3. To add a destination to the soft panel:
   a. From the **Available** list, select the destination(s) you wish to add to the soft panel.
   b. Click «. The **Assigned** list updates to include the selected destination(s).

4. To assign all the available destinations in the database to the soft panel, click >>.

5. To assign multiple destinations to the soft panel:
   a. From the **Available** list, select the first destination you wish to add to the soft panel.
   b. Press **Shift**.
   c. From the **Available** list, select the other destination(s) you wish to add to the soft panel.
   d. Click «. The **Assigned** list updates to include the selected destinations.

6. Use the provided buttons beside the **Assigned** list to determine the order in which the destinations are displayed on the soft panel.

7. Click **Apply** at the bottom of the Panels tab to save your settings.

**Sources for the Soft Panel**

You can create a soft panel with a specified number of sources and determine the order in which they are displayed in the Sources window of the panel. For example, the router may have 64 sources but you only want to make the first 12 inputs selectable on the soft panel. You would then move only the required sources from the Available list to the Assigned list.

**To specify the sources for the soft panel**

1. Double-click the panel name from the **Panels** list in the left toolbar of the **Panels** tab.
2. Click **Sources**.
3. To add a source to the soft panel:
   a. From the **Available** list, select the source(s) you wish to add to the soft panel.
   b. Click ➔.
      
The **Assigned** list updates to include the selected source(s).

4. To assign all the available sources in the database to the soft panel, click ➔.

5. To assign multiple sources to the soft panel:
   a. From the **Available** list, select the first source you wish to add to the soft panel.
   b. Press **Shift**.
   c. From the **Available** list, select the other source(s) you wish to add to the soft panel.
   d. Click ➔.
      
The **Assigned** list updates to include the selected sources.

6. Use the provided buttons beside the **Assigned** list to determine the order in which the sources are displayed on the soft panel.

7. Click **Apply** at the bottom of the Panels tab to save your settings.

**Salvos for the Soft Panel**

Before you can add salvos to a soft panel, you must configure them as outlined in the *Ultrix User Guide*.

To specify the salvos available on the soft panel

1. Double-click the soft panel name from the **Panels** list in the left toolbar of the **Panels** tab.
2. Click **Salvos**.
3. To add a salvo to the soft panel:
   a. From the **Available** list, select the salvo you wish to add to the soft panel.
   b. Click ➔.
      
      The **Assigned** list updates to include the selected source(s).

4. To assign all the available salvos in the database to the soft panel, click ➔.

5. To assign multiple salvos to the soft panel:
   a. From the **Available** list, select the first salvo you wish to add to the soft panel.
   b. Press **Shift**.
   c. From the **Available** list, select the other salvo(s) you wish to add to the soft panel.
   d. Click ➔.
      
      The **Assigned** list updates to include the selected salvos.

6. Use the provided buttons beside the **Assigned** list to determine the order in which the salvos are displayed on the soft panel.

7. Click **Apply** at the bottom of the Panels tab to save your settings.

### Adding a Favorite Button

The **Favorites** tab allows placement of common used items to aid in quick navigation on systems with many pages of sources and destinations.

The **Favorites** tab consists of a table of user defined favorites and buttons to aid their position and sorting. A **Favorite** may be deleted, edited, or deleted from the soft panel using the buttons on the tab.

**To add a Favorite button to the soft panel**

1. Double-click the soft panel name from the **Panels** list in the left toolbar of the **Panels** tab.
2. Click **Favorites**.
3. Click **Add**.

   The **Add Favorites** dialog opens.

4. Use the **Name** field to assign a unique identifier for the new favorite button.

5. Use the **Style** menu to specify the type of **Favorites** button to include. Choose from the following:

   * You cannot assign multiple styles to a single **Favorites** button.

   - **Crosspoint** — a source/destination combination where tapping this button executes a single switch request. Proceed to “To configure a Crosspoint button” to configure this button.
   - **Group** — tapping this button accesses the group as defined by the Ultrix database group categories. Proceed to “To configure a Group button” to configure this button.
   - **Salvo** — tapping this button executes the specified salvo. Proceed to “To configure a Salvo button” to configure this button.
   - **Source** — tapping this button selects the specified source. Proceed to “To configure a Sources button” to configure this button.
   - **Destination** — tapping this button selects the specified destination. Proceed to “To configure a Destination button” to configure this button.

**To configure a Crosspoint button**

1. Set the **Style** to **Crosspoint**.

   The dialog updates to display a list of available destinations and sources in the current database.
2. Use the left column to specify the destination for the crosspoint switch.
3. Use the right column to specify the source for the crosspoint switch.
4. Click **Apply**.
   
   The **Add Favorites** dialog closes.

   The Favorites table updates to include the new button type.

**To configure a Group button**
1. Set the **Style** to **Group**.

   The dialog updates to display a list of defined group categories in the current database.

2. Use the left column to navigate to the list of configured groups on the router.
3. Use the right column to select the group you want to access when the Favorite button is tapped on the panel.
4. Click **Apply**.

   The **Add Favorites** dialog closes.

   The Favorites table updates to include the new button type.

**To configure a Salvo button**
1. Set the **Style** to **Salvo**.

   The dialog updates to display a list of configured salvos in the current database.

2. Select the salvo to execute when this Favorite button is tapped on the panel.
3. Click **Apply**.
The **Add Favorites** dialog closes.
The Favorites table updates to include the new button type.

**To configure a Sources button**
1. Set the **Style** to **Sources**.
   The dialog updates to display a list of available sources in the current database.
2. Select the source to access when this Favorite button is tapped on the panel.
3. Click **Apply**.
   The **Add Favorites** dialog closes.
   The Favorites table updates to include the new button type.

**To configure a Destination button**
1. Set the **Style** to **Destinations**.
   The dialog updates to display a list of available destinations in the current database.
2. Select the destination to access when this Favorite button is tapped on the panel.
3. Click **Apply**.
   The **Add Favorites** dialog closes.
   The Favorites table updates to include the new button type.
To adjust the layout of the buttons on the soft panel

1. In the Favorites tab, select the row for the

2. Use the right toolbar to move your

3. Click Apply to save your settings.

Defining the Home Page of the Soft Panel

When creating an Ultritouch soft panel, you also have the option to customize the different areas (windows) of the panel, and determine the width of each window, drawer, and their elements. A Home Page can be a collection of windows as defined during the soft panel configuration using the options in the Panels > Home View tab.

Table 1 summarizes the options for the types of windows you can assign to the Home Page.

<table>
<thead>
<tr>
<th>Window Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category/Index</td>
<td>Displays a Category-Index style of window on the soft panel. Refer to &quot;Using Category/Index Mode&quot;.</td>
</tr>
<tr>
<td>Destinations</td>
<td>Displays the destination selection buttons as defined in the procedure &quot;Destinations for the Soft Panel&quot;.</td>
</tr>
<tr>
<td>Favorites</td>
<td>Adds a window of configurable sources, destinations, crosspoints, groups, and salvos. Refer to &quot;Adding a Favorite Button&quot;.</td>
</tr>
<tr>
<td>Filters</td>
<td>Displays text filter to find source/destination. For example, the entered text dest will find all source or destination labels that include dest* and Dest*.</td>
</tr>
<tr>
<td>Groups</td>
<td>Displays a Group Categories style of window on the soft panel. Refer to &quot;Using Group Categories&quot;.</td>
</tr>
<tr>
<td>MV Heads</td>
<td>Refer to &quot;Multiviewer Operation&quot;.</td>
</tr>
<tr>
<td>MV Layouts</td>
<td></td>
</tr>
<tr>
<td>MV Pips</td>
<td></td>
</tr>
</tbody>
</table>
Defining the Home Window Elements of a Soft Panel

The options for defining the Home Windows of a soft panel are arranged in a table format of the Home View tab. You can choose to use the default settings, or customize the width and number of rows/columns in each window independently.

The order of the rows in the Home Windows table determine the order of the windows that display on the soft panel. For example, if the first row is assigned to Sources, the first window next to the main toolbar of the soft panel will display the Sources buttons.

To define the Home Window elements of a soft panel

1. Navigate to the Panels interface.
2. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.
3. Click Home View.
4. Locate the Home Windows table of the tab.

<table>
<thead>
<tr>
<th>Window Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operations</td>
<td>Adds a window that organizes the functions for router control (TAKE, Protect, etc) into buttons as defined using the Info tab. Refer to “Elements of an Ultritouch Soft Panel” for details.</td>
</tr>
<tr>
<td>Output monitor</td>
<td>Adds a window that displays a a thumbnail of video. Refer to “Using the Output Monitor Window” for details.</td>
</tr>
<tr>
<td>Presets</td>
<td>Displays the source/destination/level switch combinations that are cued for crosspoint control.</td>
</tr>
<tr>
<td>Salvos</td>
<td>Adds a window that displays buttons representing the available salv.os (as defined in “Salvos for the Soft Panel”).</td>
</tr>
<tr>
<td>Sources</td>
<td>Displays source selection buttons as defined in “Sources for the Soft Panel”.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the level selection window and current multilevel status.</td>
</tr>
</tbody>
</table>
5. Select a row in the Home Windows table.

* Use the Up, Down, Top, Bottom, Sort buttons (located in the toolbar to the right of the table) to move a highlighted row to the desired position.

6. Click Add.

The Add Window dialog opens.

7. Use the Window menu to specify the first window to include in the soft panel.

* You cannot have multiples of the same window in either Home windows or Drawer windows.

8. Click Apply.

The Add Window dialog closes and the Home Windows table updates to include the selection.

9. Repeat steps 5 to 8 for each window you want to include in the soft panel.

10. To customize a window of the soft panel:

a. Use the Percent (%) field to specify the percentage of the overall soft panel that the window will occupy. In the example above, the Destinations window is set to 50% while the Sources window is set to 30%.

b. Use the Rows field to specify the number of rows in the panel that the window will occupy.

c. Use the Columns field to specify the total number of columns in the panel that the window will occupy.

   d. Select the Titlebar box to display a title bar across the top of the window. A title bar is only available on some window types.

11. Repeat step 10 for each window of the soft panel you wish to customize.

* The Total Width field above the Home Windows table reports the total allotted space in the soft panel. If the text is set in red, you must adjust the Percent (%) fields to ensure the total width meets 100% (but does not exceed). Otherwise the soft panel will not properly display on the Ultritouch.

12. Use the Display Icons menu to specify whether the buttons on the soft panel display the default icon images (Enable), or just the text labels (Disable). The default setting is Enable.

13. Click Apply.

   The Information dialog opens.

14. Click OK to close the dialog and save your settings.

**Defining the Drawers on a Soft Panel**

Soft panels to control an Ultrix can also include fly-out menus (drawers) that operate like horizontal drop-down menus. You can specify what menus, functions, and settings each drawer includes.
To define the drawer elements of the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.
2. Click Home View.
3. Locate the Drawer Windows area of the tab.

By default the Drawer window is populated with a right-side Status window and right-side Filters window, both occupying 50% of screen each. When multiple windows are assigned to either left or right drawers, the user must first select the drawer handle, then the window that is required.

4. Select a row in the Drawer Windows table.

The order of the rows in the Drawer Windows table determine the order of the windows that display on the soft panel. For example, if the first row is assigned to Sources, the first window next to the main toolbar of the soft panel will display the Sources buttons.

5. Click Add.

The Add Drawer dialog opens.

6. Use the Type menu to specify the location of the drawer, in relation to the window it will be assigned to.

For example, if you select Type > Left and Window > Sources, the drawer will display on the left side of the Sources window.

7. Use the Window menu to specify the window to assign to the drawer to.

8. Click Apply.

The Add Window dialog closes and the Drawer Windows table updates to include the selection.

9. Repeat steps 5 to 8 for each drawer you want to include in the soft panel.

10. To customize a drawer size:

   a. Use the Width field to specify the percentage of the allocated drawer space.
   b. Use the Rows field to specify the number of rows in the drawer will display.
   c. Use the Columns field to specify the total number of columns in the drawer will display.

You can also use the Drawer Width menu, located near the top of the Home View tab, to specify the width of the drawer handle size.

11. Repeat step 10 for each drawer of the soft panel you wish to re-size.

In the example below, the Right drawer is assigned to the Status window, and the Left drawer is assigned to the Salvos window.
12. Click **Apply**.

   The **Information** dialog opens.

13. Click **OK** to close the dialog and save your settings.
Using Soft Panels

A soft panel can be as simple or complex in its layout as you require.

Soft Panel Features

The windows and drawers a soft panel includes depends on how you configured your soft panel. The example presented in this chapter may show a different layout from your soft panels.

Windows

A soft panel is organized into distinct windows, each with a specific function. The number and type of windows your soft panel includes is determined during its configuration. Figure 5 shows a soft panel with three windows (from left to right): Destinations, Sources, and Operations.

Drawers

Depending on how you configured your soft panel, some features may be only accessed by tapping a Drawer on the soft panel. A Drawer may also display as an overlay of other windows.

Figure 5 includes two drawers: one on the far left of the soft panel, and one on the far right. When a Drawer is tapped, the arrow on the drawer points in the opposite direction. Tapping a Drawer displays additional buttons available for selection (Figure 6), or windows. (Figure 7)

Accessing the Operations Features

The Operations window can be a fixed window on the soft panel, or assigned to a specific Drawer. Figure 8 shows a soft panel with an Operations window. The buttons available in the Operations window depend on the options enabled when the soft panel was configured. Refer to “Operations Window” for details.
Filtering the Destination and Source Buttons

You can search the entries in the Destination and Source windows using the options in the Filters window. This is helpful when your database includes a large number of inputs and outputs and you wish only to access specific ones. Use the provided search fields to filter the entries in each window. (Figure 9)

Loading a Soft Panel on Ultritouch

Loading a soft panel for a router via the Ultritouch menu system is similar to loading it from the Ultrix router tree in DashBoard. You first select the specific router and then navigate to the panel file you created in the chapter “Creating a New Soft Panel for Ultritouch”. Except on the panel, the navigation options are not displayed as tree nodes, but as buttons.

To load a soft panel on Ultritouch

1. Tap ![Load Panel Icon]

   The All Connections interface displays.

2. Tap the router you want to control via Ultritouch.

   In the following example, the Ultrix_140 router was selected.

3. Tap the second button.

   The panel updates to display the router hierarchy much like the tree view in the router menu system.
Notice that the top toolbar reports where a breadcrumb trail reports your location in the menus. You can return to a previous menu by tapping < Back.

4. Tap Soft Panels.

A list of available soft panels displays.

5. Tap the soft panel for the Ultritouch you created in “Creating a New Soft Panel for Ultritouch”.

6. Tap Open.

The Ultritouch interface updates to display the selected soft panel.

**Switching with a Level, Destination, and Source**

The Ultritouch soft panels are destination driven: you must first select a destination and then select the required source to be routed.

**To make a crosspoint switch**

1. Load a soft panel to the Ultritouch as outlined in the procedure “To load a soft panel on Ultritouch”.

2. Tap the button for each level that you want to use.

You may need to first tap a Drawer to display the Status window which includes the Level buttons.

3. Tap the Destination button to include in the switch.

4. Tap the Source button that you want to include in the switch.

5. If available, tap TAKE.

If the Take mode was set to Automatic, crosspoint switches are performed automatically and the TAKE button does not display. Refer to “Adding Operation Features to the Soft Panel” for details on setting this mode.

6. If you want to protect the destination or prevent other users from changing the source selection, tap PROTECT.
Using Presets

A preset is a temporary list of crosspoint switches. Presets may be used to cue up a number of different crosspoint switches, then execute them all with one take command. Before proceeding, ensure that a Preset window is defined in the soft panel.

★ The Take mode must be set to Confirm for presets to work. Refer to “Adding Operation Features to the Soft Panel” for details on setting this mode.

To use a preset

1. Load a soft panel to the Ulritic as outlined in the procedure “To load a soft panel on Ulritic”.
2. Tap the Destination button to include in the switch.
3. Tap the Source button that you want to include in the switch.
4. Tap PRESET.
★ You may need to first tap a Drawer to display the Preset window.
5. Repeat steps 2 to 4 as needed.
6. Tap TAKE to execute all switches.

To view the preset list

• Tap VIEW.

The Preset list includes individual switches for every level that was including in the original selection.

To clear the preset list

• Tap CLEAR.

Editing the Preset List

The Preset list all the individual levels of the switch requests currently in preset queue. Individual levels may be removed from the preset queue by selecting the switch request and tapping CLEAR in the Preset window.

To edit the preset list

1. Perform one of the following:
   • Tap VIEW on the Operations window; or
   • Expand the applicable drawer to display the PRESET > VIEW button.
2. Tap individual crosspoints.
3. Tap CLEAR on the Preset window.

Using Salvos

Salvos are a selected series of crosspoints to switch in the routing matrix that are saved and later recalled for use. A soft panel that includes a Salvos window provides access to the configured salvos in your routing system.
For More Information on...
• creating salvos in your database, refer to the **Ultrix User Guide**.

**Recalling a Salvo**
Once you have created and saved your salvos, and created a soft panel with a Salvos window, you can recall each salvo from the Ultritouch.

**To recall a salvo from Ultritouch**
1. Load a soft panel to the Ultritouch as outlined in “**To load a soft panel on Ultritouch**”.
2. Tap the button for the salvo you wish to recall.

**Using Favorites**
Before proceeding ensure that:
• one or more Favorite button is defined as outlined in “**Adding a Favorite Button**”.
• a Favorite window is accessible as defined on by the Home View configuration tab.

**To use favorites**
1. Load a soft panel to the Ultritouch as outlined in “**To load a soft panel on Ultritouch**”.
2. Tap the desired button from the **Favorite** window on the soft panel.
3. If the selected favorite is a source, crosspoint, or salvo, the soft panel **TAKE** configuration setting is honored;
   • if the **TAKE** operation is set to confirm via soft panel configuration, the **TAKE** button (on operations window) must be tapped to send the switch request to the router.
   • if the **TAKE** operations is set to direct, the switch request is sent immediately upon selecting the required favorite.

**Using the Output Monitor Window**
* This feature requires that the Ultrix router run software 3v31 or higher.

The **Output Monitor** window requires:
• you to be familiar with the Ultrix feature called Destination Follow for standard destinations (outputs).
• a third-party video Codec box downstream to the router. Contact Ross Technical Support for a list of supported boxes.
Configuration Requirements

Configuring the Output Monitor window for an Ultritouch PB soft panel requires the following steps:

1. Configure a destination on the Ultrix router to feed the third-party video Codec box. Refer to the Ultrix User Guide for details on configuring destinations in a database.

2. Configure the third-party video Codec box to convert video to an IP thumbnail. Refer to the documentation that accompanied your box for details.

3. Decide whether the Output Monitor will be controlled via a standard destination-source selection, or via the Destination Follow mode.
   - The Destination Follow mode allows a user to press any destination button, and the Ultritouch output monitor will update to show the current source on that destination.
   - The Destination Follow selection requires that a destination name be entered on the Ultritouch soft panel Home View setting, and that the output monitor is defined as a viewable window on the Ultritouch soft panel.
   - The Destination Follow table in the Ultrix database does not need to be configured for this function. The destination follow table will automatically be populated when the user selects a destination button.

4. On the Ultrix router, configure a new Ultritouch PB soft panel ensuring to:
   - Use the OM Address field to specify the IP address or named resource of the third-party video Codec box.
   - Use the OM Destination field to specify the Destination the Codec is connected to.

5. Add an Output Monitor window to the soft panel (either on the Home Windows or as a Drawer feature).

5. Load the soft panel to the Ultritouch.

In the example below, the Output Monitor window displays on the far-right side of the soft panel.
Multiviewer Operation

This chapter outlines how to design and use an Ultritouch MV soft panel type for Multiviewer control via the Ultritouch.

* This feature is not supported when the router is in a system that is controlled by an Ultricore BCS.

Before You Begin

Ensure the following are completed:

- At least one UltriScape license key is installed for your router.
- At least one UltriScape Head is enabled (via the Frame Configuration interface) on the router.
- Configure the UltriScape Heads and PiPs in your router database.
- Assign each UltriScape Head to a layout.

For More Information on...

- configuring and managing the UltriScape Heads for a router, refer to the Ultrix User Guide.

Soft Panel Overview

The Ultritouch MV Soft Panel enables you to control Multiviewer layouts, switch PiPs, and modify follow/non-follow modes directly from the Ultritouch panel. This section briefly summarizes the areas and windows on a typical Ultritouch MV Soft Panel.

1. Head Selection Area

When the panel is in Layout mode (LAYOUT is tapped), this area displays the available Ultriscape heads. Tap a head icon to select (Figure 11 shows slot 4 Head 1 as selected). Items that have a gray background are not selectable as they are not configured in the Ultrix database.

2. Layout Selection Area

When the panel is in Layout mode (LAYOUT is tapped), this area displays the available layouts as configured in Ultrix. Tap a head icon to select from the head selections area, then select a layout to switch the head layout. The current selection is shown with a green outline. Figure 11 shows that the first available layout is selected.
3. Control Area
   This column of buttons enables you to select an element of an UltriScape Head to display in the soft panel.
   › **LAYOUT** — tap this button to display the MV Layouts options.
   › **PIP** — tap this button to select display the MV PiPs options.
   › **APPLY** — tap this button to apply any changes made to the Ultritouch MV soft panel.
   › **TAKE** — tap this button to perform a crosspoint switch.

4. Sources Area
   Each button in this area represents an input in the routing system. Tap a button to include assign the source to the currently selected PiP.

5. Right Drawer
   A navigation drawer is available on the right sides of the UltriScape MV soft panel. Tap the drawer icon once to open a pane that provides access to the Destinations Follow window. Tap the drawer icon again to close the pane.

6. Head Preview Area
   When the panel is in PiP mode (**PIP** is tapped), this area displays a preview of the selected layout.

7. PiP Selection Area
   When the panel is in PiP control mode (**PIP** is tapped), this area displays the available PiP destinations. Tap a PiP destination button to select, then select a source from the sources area to switch the PiP source.

**Creating a Soft Panel for Multiviewer Operation**

Much like other types of soft panels, when you create a new Ultritouch MV soft panel, you select from an existing soft panel type (templates). You then assign a Panel Name and ID to display in the tree view using the nomenclature “**Panel Name [#]**” where [#] is the Panel ID.

**To create a new soft panel for Ultritouch**

1. Locate the Ultrix in the Tree View of DashBoard.
2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.
3. Expand the **Database** node.
4. Double-click the **Panels** node.
   The **Panels** tab opens.
5. Click **Edit... > Add**.
   The Add Panel dialog opens.

6. Type a unique identifier in the **Name** field.
   This will be used to identify the panel in the tree under the Soft Panels node.

7. Use the **Style** menu to specify **Ultritouch MV**.

8. Click **Apply** to save your settings and close the Add Panel dialog.
   The new panel name is added to the **Saved Panels** list of the Panels tab and is automatically selected for editing. In the following example, the **UTouch_MV1** soft panel was created.

To edit the Ultritouch MV soft panel operational features
1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.
2. Refer to the following to configure the required elements of the Ultritouch MV soft panel:
   • “Adding Operation Features to the Soft Panel”
   • “Levels for the Soft Panel”
   • “Destinations for the Soft Panel”
   • “Sources for the Soft Panel”
“Salvos for the Soft Panel”

Home View of an Ultritouch MV Soft Panel

By default, an Ultritouch MV Soft Panel is automatically configured to display the following:

- **MV Heads** — provides access to the UltriScape Head Selection options of the connected router. Use this window to switch between the heads that are enabled on the router.
- **MV Layouts** — provides access to the UltriScape Layout Editor of the connected router. Use this window to switch between layouts saved to the router database.
- **MV Pips** — provides access to the defined UltriScape PiPs of the connected router. Use this window to switch between configured PiPs.
- **Sources** — provides access to the available sources in the current database of the router.

The Destination Follow drawer is not implemented.

![Figure 13 Example of the Home View tab of an Ultritouch MV Soft Panel](image)

Using an Ultritouch MV Soft Panel

There are three basic functions of an Ultritouch MV Soft Panel: layout control, PiP selection, and enabling a PiP to follow a destination. This sections briefly outlines the elements of an Ultritouch MV Soft Panel and how to perform these basic functions.

If communication is lost between the Ultritouch and the router, changes made during run-time on the Ultritouch MV Soft Panel are not retained.

Layout Control

Each UltriScape Head in your system can use the same layout, or different layouts depending on your needs. Both instances share the same layout properties, but can have different sources assigned to each PiP. The list of available sources to assign to each PiP depends on the currently loaded database for the Ultritouch router.

To change the layout loaded to a specific UltriScape Head

1. Load the soft panel as outlined in “To load a soft panel on Ultritouch”.
2. In the MV Heads window, tap the UltriScape Head you want to control.
3. In the Control window, tap LAYOUT.
Inactive UltriScape Heads are grayed out and may not be selected for control.

4. In the MV Layouts window, tap the layout from the MV Layouts window. The selected layout displays with a green border around its thumbnail.

5. Tap Apply to confirm your selections and change the layout from the selected UltriScape Head.

**PiP Selection**

A PiP source is controlled by routing just like any destination. Each PiP in a layout is assigned a video signal from the Head Selection interface. If the input signal includes embedded audio, the audio is included in the UltriScape Head output.

**To change the source for a PiP**

1. Load the soft panel as outlined in “To load a soft panel on Ultritouch”.
2. Select a layout as outlined in “To change the layout loaded to a specific UltriScape Head”.
3. In the Control window, tap PIP.
4. In the MV Pips window, tap the PiP you want to control.
5. In the Sources window, tap the source that you want to use for the selected PiP.
6. Tap Apply to confirm your selections and change the PiP Source.
Using Categories

This chapter outlines how to use an Ultritouch soft panel that includes Category Index and Group Category elements to perform crosspoint switches on an Ultrix router.

Using Category/Index Mode

Category/Index mode allows alpha-numeric extensions to labels to “build up” the final label selection. Destination and source names are split into substrings - the first substring is referred to as the category and the subsequent substrings as the indexes. Once the Cat/Index categories are defined, the user can perform switches on the Ultritouch based on the categories.

Before You Begin

Before you can load a soft panel with Category Index elements, you must first:
1. Assign categories within the Ultrix database.
2. Assign indexes within the Ultrix database.
3. Configure an Ultritouch soft panel to include a Category Index window.

For More Information on...
• on assigning categories and indexes, refer to the Ultrix User Guide.

Soft Panel Overview

Figure 14 provides an example of an Ultritouch soft panel with a Category Index window and buttons.

![Figure 14  Example of a Default Category/Index Soft Panel Layout](image)

1. **Category Index Window**
   This window provides access to the Destination and Source buttons for selected categories and indexes defined in the Ultrix database. The buttons that display in this window change depending on whether the DEST or SRC button was tapped. In Figure 14, the user tapped SRC, and the Category Index window displays buttons assigned to the Source category.

   A Category Index window is added to an Ultritouch PB soft panel during configuration as outlined in “Defining the Home Page of the Soft Panel”.

2. **Status**
   This area reports the current selection (Dest and Src).

3. **Button Paging**
   Tap these buttons to scroll up/down the window.
4. Operations Window

The Operations window includes the following buttons for Category/Index mode:

- **DEST** — Tap this button to display the Destination category buttons in the Category Index window.
- **SRC** — Tap this button to display the Source category buttons in the Category Index window.
- **BACK, CLEAR** — Use these buttons to back up one step and clear current selections respectively.
- **SELECT** — Tap this button to confirm your crosspoint choices. This button is only available when the **SRC** and **DEST** selections are valid.

Creating a Soft Panel for Category/Index Mode

Creating a soft panel for operating an Ultrix router in Category/Index mode requires the same basic steps as other soft panels except you set the Window type to

**To create a new Ultritouch soft panel with a Category/Index window**

1. Ensure that you assigned the required categories and indexes within the Ultrix database.
2. Create a soft panel as outlined in the procedure “To create a new soft panel for Ultritouch”.
3. In the Panels interface for the new soft panel, click Home View.
5. Click Add.
   
   The Add Window dialog opens.
6. Use the Window menu to select Category/Index.
7. Click Apply.

   The Add Window dialog closes and a new row displays in the Home Windows table.

8. Use the Up, Down, Top, and/or Bottom buttons to position the Category/Index row within the table. This will determine where the window is located on the finished soft panel.
9. Use the Percent (%) field to specify the percentage of the overall soft panel that the Category/Index window will occupy.
10. Use the **Rows** field to specify the number of rows in the panel that the Category/Index window will occupy.

11. Use the **Columns** field to specify the total number of columns in the panel that the Category/Index window will occupy.

12. Click **Apply**.

   The **Information** dialog opens.

13. Click **OK** to close the dialog and save your settings.

**To create a new Ulritouch soft panel with a Category/Index window in a drawer**

1. Create a soft panel as outlined in the procedure “**To create a new soft panel for Ulritouch**”.
2. Edit the soft panel as outlined in the procedure “**To edit the soft panel operational features**”.
3. Click **Home View**.
4. Locate the **Drawer Windows** table in the Home View tab.
5. Click **Add**.

   The **Add Drawer Window** dialog opens.

6. Use the **Type** menu to specify whether the Category/Index window will be displayed on the **Left** Drawer or **Right** Drawer.
7. Use the **Window** menu to select **Category/Index**.
8. Click **Apply**.

   The **Add Window** dialog closes and a new row displays in the Drawer Windows table.

9. Use the **Up**, **Down**, **Top**, and/or **Bottom** buttons to position the Category/Index row within the table. This will determine where the window is located on the drawer.

10. Use the **Percent (%)** field to specify the percentage of the overall drawer that the Category/Index window will occupy.

11. Use the **Rows** field to specify the number of rows in the drawer that the Category/Index window will occupy.

12. Use the **Columns** field to specify the total number of columns in the drawer that the Category/Index window will occupy.
13. Click **Apply**.
   The **Information** dialog opens.
14. Click **OK** to close the dialog and save your settings.

**Using Category/Index Mode**

كرة The categories and indexes must be defined in the Ultrie router database before Ultrie can control the router using Category/Index mode.

**To make a crosspoint change**

1. Load a soft panel, configured for Category/Index mode, to the Ultrie as outlined in the procedure “**To load a soft panel on Ultrie**”.
2. To select a destination:
   a. Tap **DEST**.
   b. Tap a Destination category.

3. Tap a Destination Index.

4. Tap **SELECT** to confirm your destination choice.
   **كرة The SELECT button is only enabled when the selections made in steps b and 3 are valid.**
   The panel enters Source Selection mode.

5. Select the Source Category.

6. Select the Source Index.
• **TAKE** becomes available when the navigation results in a valid source selection.
• **PRESET** may also be used to add multiple switches to a **PRESET** cue. The **PRESET** cue can be then executed with a single **TAKE** command.

7. Tap **TAKE** to send the switch request to the router.

---

### Using Group Categories

Group categories allow arbitrary grouping of source and destination names. These groupings are fully customizable to suit your particular workflow.

#### Before You Begin

Before you can load a soft panel with Group element, you must first:

1. Define the group categories within the Ultrix database.
2. Configure an Ulritouch soft panel to include a Group window.

#### Soft Panel Overview

**Figure 15** provides an example of an Ulritouch soft panel with two group categories defined as EDIT 1 and EDIT 2. Both contain various source and destination names. EDIT 1 also contains a sub-group.

1. **Title Bar**
   
   If enabled, a title bar will be displayed top most of the screen. The current group navigation will be displayed as a breadcrumb style upon entering any group.

2. **DEST Mode Button**
   
   Select this button to show only destinations from any group

3. **SRC Mode Button**
   
   Select this button to show only sources in any group

4. **LEV Mode Button**
   
   Select this button to show only levels in any group
5. **TOP Button**
   Select this to navigate to the top most group

6. **BACK Button**
   Select this to navigate back one step in the group hierarchy

7. **Central Area**
   The central/main area of the screen displays the groups and any configured source/destination/level buttons. The Groups are identified by the folder icon.

   A group category is only visible if it contains defined contents for the current mode selected. For example, if the current select mode is DEST, and group EDIT 2 contains no destinations, then the EDIT 2 group will not be navigable in DEST mode.

**Using Group Categories on a Soft Panel**

This section outlines how to perform a simple crosspoint switch via a soft panel using Group categories. There are three steps you must perform before sending the switch request to the router:

1. Select the required level(s). There are two methods for selecting a level: using the group category defined levels, or using the status window.
2. Select the required destination.
3. Select the required source.

**To select the required levels for the operation**

- Using the group category defined levels:
  a. Tap **LEV**.
  b. Tap the required level(s).
   
     A selected level will highlight blue. To unselect, tap again.

- Using the status window:
  a. Open the status window (if needed)
  b. Tap the required level(s).

   Omitting a level selection will mean the switch request will use the current level selection from a previous operation.

**To select the required destination**

1. Tap **DEST**.
2. Navigate to the group.
3. Tap the required destination.

**To select the required source**

1. Tap **SRC**.
2. Navigate to the group.
3. Tap the required source.
To perform the switch

- If the **TAKE** operation is set to **Confirm** via soft panel configuration, the **TAKE** button (on the Operations window) must be tapped to send the switch request to the router.

- If the **TAKE** operations is set to **Direct**, the switch request is sent immediately upon selecting the required source.
Glossary

The following terms are used throughout this guide:

**Breakaway** — an act of performing a switch on only some of the signals grouped together under one label.

**Connection Point** — setting to define a communication connection between Ultritouch and a device in the routing system.

**Crosspoint** — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires one crosspoint.

**Destination** — a signal output from the routing system.

**Hard Panel** — the physical Ultritouch panel that provides a touchscreen interface to the menu system.

**IP Address** — a setting that defines the Internet protocol address of a device within a network.

**Label** — text that is used by control displays to identify a signal as an input or output.

**Level** — refers to a section of a routing system. For example, a video router would be one level and an audio router would be a second level.

**Logical (virtual) Label** — a name for a group of routing system inputs or outputs.

**Logical (virtual) Routing** — the action of switching a group of otherwise unrelated signals via a common label (name).

**Remote Control Panel (RCP)** — a physical hardware panel of buttons that is used to control the routing system.

**Salvo** — a system wide sequence of matrix control operations and crosspoint actions.

**Soft Panel** — a DashBoard software interface that represents a panel of buttons that is used to control the routing system.

**Source** — a signal input to the routing system.

**Virtual Label** — a name for a group of routing system inputs or outputs.

**Virtual Routing** — the action of switching a group of otherwise unrelated signals via a common label (name).